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GETTING STARTED

Introducing RemoteX

RemoteXs a powerful new application that allows you to share your desktop with another user while

on a Skype call. & f Avérstoé of our standardettingRemoteCall 4.6emote supportsoftware,

RemoteXdownloads and installs in minutes on any Windowgdt@tel Macs with virtual Windows
machinesyunning Skypendprovidesinstant access to desktop sharing.Skype, imply click orthe

Tools > Do Morenenu (or rightclick a contact and seleEto Morefrom the drop down menu) and

select theRemoteXicontosht NB &2 dzNJ RSa1d2LJ 2NJ 9AS¢6 +FyR S@Sy il

Work on a single document together as if you were at the same desk.
Collaborate on a web page.

Teach a friend how to use new software by showing them in real timtheainPC.
Surfthe Internet together.

View photo albums and slideshows together.

Show PowerPoint or other presentations.

Fix pesky computer problems.

X X X X X X X

Simple desktop sharing added to the already free and easy Skype.

Terminology Used

Local PC Thecomputeryou are using t@onnect with a friend or family member
Remote PC . 2 dzNJ O P@ ik aterefnately connectimgth via Skype

Session The connection between the local and remote PCs

P2P A direct connectiorfpeerto-peer)between two PCs

Gateway A connection between two PCs relayed through a web server

VRVD Virtual Remote Video DrivéW¥RVD) isRemoeX@ proprietary video driver
GDI Graphic®evice Interfacésa Windows video driver

Session Status Window The window displayed on the remoRCdesktop indicatingan activesession
Extras Manager A direct link to Skyp® plugin database allowing you to downlodlde latest plugins

APl Access Control Manage Skyp@ plugin permission settings via the API (application programming
interface) Access Control Console

Cordeos Corp. | RSUPPORT CO,. @208 www.remotecall.com
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RemoteX Quick Connect

Thislittle section explainfust how easy it is to get up and running wiemoteXfor the first time.

Since you are already connected to y@ontacts via Skype, you can connect your computer to theirs in

three easy steps

1. Download and install thRemoeXplugin from the SkypeExtras Gallery.

2. A splash screen will ask if yoamt to Invite someone to use this ExtraChoose the person you
would like to connect with from the list of available contacts and then Gimhtinue.

3. RemoteXwill automatically send a Skype Extras link to your contact so they can install the plug

in. As soon as they have installed it, you will automatically be connected!

NOTEWhen running RemoteX for the first time you will be prompted to select the Skype
permission setting. You must select ti&llow this program to use Skypgeoption or RemoteX
will not function.

From that point on, connecting is as simple as sele@adviore >RemoteXfrom your Skype menu and
then selecting the person you would like to connedihwiThe other way to do it is to righdick on the
contact you want to connect with, then selddb More >RemoteX TheRemoteXplug-in will do the rest.

System Requirements

Local and Remote PC

oS Windows 200€P003, XP Vista
Hardware Pentium II 1-GHzor higher

Web Browser MS Internet Explorer 5.0 or higher
Disk Space 8 MB

Internet Connection 56 kbps modem or higher

Technology and Security

RemoteX does not contain any adware, spyware or other malv@oenecting through one of our relay
servers, a direct link is established between the PCsand is maintained untthe user ends the
sessionWe also guarantee the fastest remote connectpmssible due tiRemoteX2 @ + A NIi dz- f
Video Driver (VRVD) and high speed packet switching technology.

Cordeos Corp. | RSUPPORT CO.@aD08 www.remotecall.com
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Downloading Remot eX

TodownloadRemoteXto your local PGjou can use th&kype Extras Manager download the.sparc
file directly from our website(www.remotecall.com/remotex.a9pTo see a video of the installation
process, follow this linkattp://www.remotecall.com/remotex/demo.asp

Using he Skype Extras Manager

1. Loginto Skype and clidlools > Do More > Get Extras

') Skype™ - cooljerkatlarge

(E=1 o8 ==

File Account Call Chats View VTuulsr Help

Q -G-— 1
) call cheaply to mobile phones an
7 SkypeFind 5 hu

|

L Contacts @ call Phona‘
Q@ Add E Search g Conferen|

o \
@ ‘

/w» Play games

i‘i Vaancy

@ Unyte Application Sharing
& skypify Outlook with Skylook

[ ) Have fun: Draw together
i".‘) Backgammon

ﬂ Chinese Checkers

@ Examine DRM Status Sample Extra
E Parkalot Singleplayer

Organize your Extras
Get Extras s

Change Language »
" Share Skype with a Friend

@ CrazyTak

Q Pamela MP3 Call Recorder

m Ringjacker ™ 5
(CS] Last.fm Radio 7!3[)21“*5..."

798 people online

Add a Contact...

Search for Skype Users...
Import Contacts...

Call Forwarding...
Voicemail...

Send SMS Message...
Send Money...
Send Contacts...

Advanced »

Options...

2. ClickSharingfrom the plugin categorieson the left

Q Featured 17
° New 4
g Sharing [} 12
QP Personalise 11
Bz Productivity 13
ﬂ Business 9
x Miscellaneous 10
ﬁ Movies 1
Remote access 1
";:a Community 7
‘w Games 16
0 My Extras 2

Note: If you do not see RemoteX listed in the Extras Manager > Shar
category, you must update the Extriskanager.

To do so:

1. ClickOptionsin the bottom left corner of the Extras Manager
2. ClickUpdate Nowfrom the update tab and wait a few moment

Once the Extras Manager has updated itself the jtugshould be visible
from the Sharing category and ready forvadoad.

Cordeos Corp. | RSUPPORT CO,.@2008 www.remotecall.com


http://www.remotecall.com/remotex.asp
http://www.remotecall.com/remotex/demo.asp

RemoteX User Guide Page| 4

3. FindRemoteXin the list of applications on the riglaind clickhe greenplaybutton to open the
download theplugin.

RemoteX Free

Connect with remote
- desktops quickly and
easily!

o

4. Anlinstall new Extrasplash screen will appear. Click the checkbox nekatyree and accept the
terms ofthelLJdzo f A Aa KSNRA 9y R !, ,#héNicfoOKk OSyasS ! ANBSYSyi

Skype™ Extras Manager =)

_‘3 Install new Extra
f

<
. 4

This will install and start * RemoteX” published by "RemoteCall” not

Do you want to continue?

Warning/disclaimer for non-certified Extras:

The application you are about to install will be used entirely at your own risk.
Skype does not make any representation or warranty as to the accuracy,
completeness, condition, suitability, or performance of the application, nor as
to the absence of malware, spyware, adware, viruses or any other
destructive or contaminating features. The use of the application will be
subject to the provider’s user agreement.

I agree and accept terms of publisher's End User License Agreement
View license agreement

5. A dialogue box will appear asking youstnvite someone to use this Extéa If you want to
connect to one of youcontacts, select their name from the list and cl@&ntinue

" Skype™ - RemoteX [ =@ ===

v H Invite someone to use this Extra

RemoteX
Connect with remote desktops quickly and easily!

Please select who you want to invite to use this Extra: NOte If yOU d(}/ Q u é I y U U 2 O 2 y

: 5 e - contact right away then just clicRancel

£3 £5
&
m

00— You can launch a session afterwards by clickin
nt: G contact from your Skype contacts list.

Cordeos Corp. | RSUPPORT CO.@aD08 www.remotecall.com
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6. RemoteXshould now be installed and ready to work with Skype.

3 Sype - qum—

(E=3EoR "X

File Account Call Chats View Tools Help

Pagel|b

G~ Jeff
Q) call cheaply to mobile phones and landiines
J = SkypeFind D History

“ a AT
a4 Contacts Call Phones  «4s Live

@ Add { Search g Conference

-
Y@ start Call
|© start Chat...

Tlum Send Contacts...
U |1) Send File...
<

< I (. poy cames

=)
Rename... h pacicy

[P send Money @ Unyte Application Sharing
Set Speed-Dial..
o — " ) Skypify Outlook with Skylook

Remove from Contacts
@ CrazyTak

& Block This User
Request C Q Pamela MP3 Call Recorder

% ) Have fun: Draw together
Lo
%% Backgammon

ﬁ Chinese Checkers

E Parkalot Singleplayer

Organize your Extras

& Remotex I

Get Extras

Downloading fom RemoteCall.com

Go towww.remotecall.com/remotg.aspand clickGet RemoteX Nowfrom the side bar on the right.
After downloading, double click tHeemoteXicon to start the set up procesRefer to stepg-6 from

the previous section.

Cordeos Corp. | RSUPPORT CO,.@2008
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Connecting with a Skype User

1. Rght-clicka Skype conta@nd selecDo More > Rema@X

{v) Play games [oovore ]
Joee @ View Profile
[+ ] EEE] Rename...
@ Unyte Application Sharing [ Send Money
Set Speed-Dial...
&) Skypify Outlook with Skylook
Remove from Contacts
@ CrazyTalk & Block This User
E Record Skype Calls Request Contact Deta
. .7 Have fun: Draw together L) View Chat History

T 5,761,114 people
5% Backgammon

&
@ Chinese Checkers

,. RemoteX
Organize your Extras
Get Extras

2. The remote user will be prompted to accept the invitation to &moeX

r = h
2, Skype Extra invitation = | E e |
. P Invitation for RemoteX

RSUPPORT ot bt
has invited you to play RemoteX

| 000

[ Accept ] ’ Dedine ]

Note: If the remote user does not have the Skygeg-in installed, they will automatically be
prompted to download it. This may take a minute or two depending on their internet

connection.

3. Once your invitation has beeatceptedyou will have the choice of:

a. Displaying your screen to the remote user

b. Viewingthe remote use®screen
Make your selection and clicko

Screen-Share Request

Choose your connection method with RSUPPORT (rsupport.test)

l? @ Show Your Desktop
o

View Remote Desktop %?

Ready

(@) RemoteX (BN 5c

Cordeos Corp. | RSUPPORT CO,.@2008

IMPORTANT!

When running RemoteX for thedt time you will be
prompted to set the permission for the pltg.

. 2 dz Y dza Allow tBig pfodram tduse Skype
or RemoteX will not function.

This must be done by both you and the remote us

Note: In some situations this window may not
appear, intead you will see a red event flag appea
under your name. Click this event flag and click
remotex.exeto set the permission setting.

www.remotecall.com




RemoteX User Guide Page|7

USINGREMOTEX

Local User Interface

Connection View Tools Help
R #- 2 i
/ \ 7 XN
o
i <fioe

Main Menu andToolbar

— — MIKE-DESKTOP, 1000103 I ) =
Remote PC Name and IP Addrer =

Session Status WindowL

—

StatusBar

|lP2p |[1024x768 32b% |16 bits _|[00:02:51| /|

|www.rsupport.com

Main Menu and Toolbar

The features oRemoteXare easily accessegsing astandardmenu systemand/or abutton icon
toolbar. TheRemoteXnterface includes the following menus and toolbar:

€3 RemoteX - MIKE-DESKTOP, 10.0.0.103 I [P

Connection View Tools Help
-:?.P'(' f ﬁ _
& Keyboard/Mouse Controtakes control of the remoteé / Qa 11 S@02FNR FyR Y2dzaSd
R Mouse Chasdlisplays the realime location of the remotd>@ mouse cursor.
* Laser Pointehighlights sections of the remote desktop, using a dot or arrow.
4

Draw allowsyou to draw on the remote desktop in real time.

Zoomadjusts the scale of thRemoteXConsolén sizes of 50%, 60%, 70%, 80%, 90% and 100%.

= @l

Performance Optimizatioi SG Q& &2dz AYLINR @S aSaaizy LISNF2NXIy
display settings ilRemogeXduring the session.

Cordeos Corp. | RSUPPORT CO,.@2008 www.remotecall.com
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TheRemoeXinterface includes the following menus:

Connectiong Session management amdnnection information
View ¢ Screen size optiorendtoolbar/interface settings
Toolsg Tools andPerformance Optimization

Help¢ Information aboutRemoeX

T [T T T

Disconnect Disconnects thectivesession.

Connection Displays relevant information about the current session, such as, connection,status

Information connection method (Gateway or P2Rjtal session timgandremote PC name, IP, and
OS version.

Exit Exits and closeRemotX

Use the View menu to configurthe RemoeXConsolescreen size and user interface

features.

FulkScreen Maximizes theRemoeXsession window to full screen. A quick menu is available at tt
top of the screen while in full screen mode. To return to a resizable viewer window,
the Full Screen icon.

Fb2GSY ,2dz Oly 2yfeée SyGSNI Fdz t aheSanyg
2N KAIKSNI GKIy GKS 20Kt t/ Qaod

Window-Scale to Fit Scales the image of the remote desktop to fit within the session window.

Toolbar Displays/hideshe followingBasic ®olbar at the top othe RemoeXConsole
f Basic Toolba® ® # /7 & %
Status Bar Displays/hides the status bar at the bottom of the session window.
Tools Use the Tools menu to select a speciRemoeXtool or function. |
Always on top Places th&RemoeXConsoleon top of other windows.
Tools AccesRRemoeXsupport tools and functions:
g R IE

Session Status Window €2 Remote Control in session E]__
Remote-Support System 5H4_ @

To stop mousefkeyhoard control, press

Once connecteda remote user applethe SessiorStatus
Window, should appear on the remote desktop.

"G+ Al + Shift
This applet allows for quick control of the remote session. Cliert Cartral in session.
Either user can clidRisconnecto immediately end the
’

connection. A remote user can also immediately susperser
control of the mouse and keyboard by pressigl + Alt + Shift

Cordeos Corp. | RSUPPORT CO,.@2008 www.remotecall.com
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Display Options

Zoom and Scale-To-Fit
During a session you may want to adjust the size of the viewer to fit the entire image of the remote

desktop. You cado this in two ways.

First, you may try adjusting the zoom percentage of the image. By default the image is zoomed at 100%,
however the remote desktop may have a larger screen resolution tiiatocal PC you are using

By clicking th&oomicon [ you can adjust the scale dig¢ displayedmage until it fits within your
window.

Thesecond ways to clickWindow-Scaleto-fit from the dvViewe menu. This will automatically scale the
current image to fit within the viewer.

Full-Screen Mode
During a session yatan view the remote desktop in ftdbreen modeVYiew > FullScreen Modé.
You can use the Basic Toolbacatedat the top of the screemo access tools and featureghile in fulk

screen modeYou can exit fubcreen mode at any time by clicking tBgt FuII—Screericon.
1 2 3 4 5 6

I= #- 7 %

Exit FulScreen
Mouse/Keyboard Control
Mouse Chase

Laser Pointer

Draw

Performance Optimization

© 0k wdhPE

Display Color Depth
You may customize the color depth in tRemoeXConsole to enhance
image quality or improve performance. OpBerformance

Optimization i} and select theseneraltab, thenadjustthe color
depth of theLocal Display

Cordeos Corp. | RSUPPORT CO,. @208 www.remotecall.com



